
 

 

TSLOPE RELEASE NOTES 

 

Version 2.3.1.19980.2 December 30, 2025 

- Fixes for extent in WFS, arcgisfeature services for QGIS 

- Added ability to read COPC point cloud LAZ files. 

 

- Added caption actors with labels for point annotations when the number of points in an 

annotation file is up to 10. 

 

- Better handling of GIS files for drillholes with data down the hole with the same XY 

location. 

 

- Updated wxPython from 4.2.3 to 4.2.4 released 2025-10-28. No major changes. 

  Release notes at 

  https://wxpython.org/news/2025-10-28-wxpython-424-release/index.html# 

- When reading a QGIS file, let the user select the EPSG for the TSLOPE project. 

  The default is the QGIS project EPSG. 

- Updated VTK from 9.4.2 to 9.5.2. 

 

Version 2.3.1.19451.2 October 6, 2025 

- Added a new input facility to import data described in a QGIS .qgz file. Open the QGIS .qgz 

file by right-clicking the QGIS input tree node.  Data can be imported by right-clicking the 

map-layer, once a top surface is added. 

- Added transform of geoimages to the project EPSG, if the image EPSG differs. 

- Surface or layer can be added from an extruded section volume. 

- Added import of GeoJSON files. 

- Added OGR GIS export of boundary lines. 

- Added slope GIS extent for 2D slopes and intersection line for 3D slopes. 

https://wxpython.org/news/2025-10-28-wxpython-424-release/index.html


- Added to export of GPKG file: loads and zones. 

- Added export menu item to save a GIS GPKG file of the project bounding box, boundary 

lines if defined, cross-sections if defined, and reinforcement groups if defined.  The export 

file is a GPKG file that may be imported into GIS programs such as QGIS. 

- Added import of HYRCAN files 

- Added export of 2D slope case as HYRCAN javascript .hjs file. 

- Added new failure criterion SHANSEP. 

- Added to surface panel “Ambient” (default 100, max 100) and “Diffuse” (default 20, max 

100) fields to adjust the look of a surface. 

- Added ability to use original Hoek-Brown parameters, but setting not to use the GSI 

parameter. 

- Updates for reading GEO5 Slope Stability XML files to deal with mixed units. 

- Added no data value, with default values of 0.0, when merging DTM files. 

- Added geographic metadata (GMD) from a .xml file if it exists for geoimages and 

annotation files. 

- Adapting reading of annotation files with more than one layer. 

- Updated VTK from 9.4.1 to 9.4.2. 

- Added an icon for the reinforcement layout. 

- The reading of Wavefront OBJ files has been extended to include the ability to use texture 

files. 

- Added reading colours from LAS/LAZ files. 

- Added LAS/LAZ files as annotation files. 

- Updates to using PROJCS when EPSG is missing 

- Added clipping of columns in a 3D slope by a boundary line; only single line segment (2 

points) or a closed polyline.  The selection of columns excluded can be changed using the 

“invert” option. 

- When loading a surface file with multiple regions no longer ask the user whether to add 

separately or not – just add each region if it has more than 5% of faces of the larges region. 

Each surface should have only one connected region. 

- Added checkbox for cropping surface to project clip bounds. 

- Ensure that top and bottom layers from a volume have only one region. Similarly ensure 

that cropped surfaces have only one region. 

 



Version 2.3.0.17017.2 April 5, 2024 

- Added menu item to show/hide anchor tendons in the project view. 

- Added controls for changing the contour line colour and line width. 

- Added set visibility of vertical uniform load in the project view. 

- Added distance measurement in the project view from the Data menu -> Distance. 

- Added influence angle to the reinforcement group. The default value is 30 degrees. 

- New WGS84 field in the project panel. When an EPSG coordinate is defined, pressing "<Shift> g" 

will open the project's location in Google Maps on the user's web-browser. 

- Added help string for seismic kh and kv. 

- Added a view menu item for 2D slope to hide load labels. 

- When adding a geoimage TIFF file, the user is asked whether they wish to translate to a JPEG file 

and use that instead. This allows TSLOPE to use a smaller geoimage file. 

- When loading a geo-image, the maximum file size is now related to the available memory on the 

computer. 

- Added 'Delta Z' for boundary line so that user can adjust how far above a surface it is drawn. 

- Add, in Maptek information panel, Vulcan GeologyCore to Maptek applications supported by 

TSLOPE. 

- Added a Maptek panel for viewing basic information about a Maptek object. 

- New menu item for a Plane surface to "Expand" the plane to the project's bounding box.  

- Added slope materials legend visual properties into the bottom of the Slope panel.  Note that the 

3D slope materials legend only appears when the Data menu is set to Material colours. 

- Improved display of Z-axis values. 

- Added view menu items for Project and Slope views of the reinforcement load lines. 

- Added view menu item for displaying the top and basal surface intersection line for 3D slopes. 

- Allow the user to set cross-section length from either the start-point,  or the end-point. 

- Updated to Maptek SDK 1.5 released 2023-03-23; previous version used was 1.4 2022-08-23.  

- New feature: add importing of KML/KMZ files as annotations. For this to work the Project EPSG 

MUST be defined before importing the KML/KMZ file.  KML files may be created by carefully writing 

in the required syntax using a text editor. 

 

Version 2.3.0.14668.2 April 21, 2023 

- Improvements for importing Slide and SLOPE/W 2D slope models. 

- Improvements for reading xyz, las, and laz files 



- New feature when reading OBJ files with more than 100000 points – a Voxel grid is used to create a 
simplified surface. 
 
- Update of 2D slope display Z bounds. 
 
 

Version 2.3.0.13988.2 December 16, 2022 

- When importing a SHP file with points, drape the points on the defined surface. 

- Enhancement to create a surface from a DXF file with POLYLINEs with PolyFaces. 

- Enhancement to read anchors from a DXF file where the anchors are defined with the name 
‘anchor’ in the name and are defined by INSERT and BLOCKS entities. 
 
- Updated Maptek SDK version 1.40 

 

Version 2.2.1.12822.2 August 29, 2022 

-  Expanded accepted left and right x values during critical search. 

- Check for non-contiguous columns for 2D slopes. If non-contiguous columns are present a message 

is displayed to the user at the end of an analysis. 

- Fix for critical search when tension-crack is present and the trial circle does not intersect the 

tension-crack, where previously this reset the tension-crack depth to 0.0 

- Fix for geosynthetic reinforcement for 2D slopes (3D slopes not yet supported). 

- For 2D critical search include bend points in the top surface (> 20 deg.) for toe and crest which may 

be possible points where the failure surface could pass. 

- Add tolerance for reinforcement where the cross-section is exactly midway between 

reinforcements, and excluded even though reinforcement spacing is the same as the corridor width. 

- Added "Export as DXF" menu item to 2D slope nodes, to allow import of geometry into other slope 

stability programs. 

- Updates to reinforcement groups. Right-click menu presents new items: 
  - Import CSV file 
  - Edit reinforcements -> dialog box to edit individual reinforcements 
 
- Reinforcement editor has right-click menu for following operations: 
  - Delete reinforcement 
  - Duplicate current reinforcement 
 
- For Anchors have two "subtypes" 
  - Soil Nails (assumed fully grouted) 
  - Grouted tieback, bond length is less than the total length. 
 
- Each anchor has an associated load line, to show capacity along the length of the anchor. 
 



- Add export of vertical uniform load points as a CSV file. 

 

- Added help information about file format expected for boundary lines, which are CSV files, one 

point per line. 

 

- Fix for filenames that include '&' character. 

- Added a plot of the side force function for the Morgenstern-Price method. To display select the 

side force function drop down list and click the button at the right-hand end of the control. 

 

- Added the clipped-sine side force function for the Morgenstern-Price method. 

- Added Morgenstern-Price method for 2D slopes only.  

  The side force functions currently available are: 

   * half-sine 

   * constant (Spencer) 

  * power-sine (see 2005 Zhu, Lee, Sian, Chen, Can Geotech. vol 42) defined by 2               

parameters.  NB: Some choices of parameters may have the line of thrust outside the slope. 

- For EPSG field add button to lookup https://spatialreference.org and https://epsg.io 

- Added analysis methods to Pile types: shear force, Ito-Matsui 1975, and equivalent fluid weight. 

Updates to pile forces for each method. 

- Annotations have options for either (a) draped, or (b) display as 2D at a display Z elevation. 

- Add for anchor and pile reinforcement types, a definition type id by either (a) a boundary line for 

reinforcement layout, or (b) import a CSV file with head point location and other parameters such as 

length, and dip and bearing for anchors. 

- For a Delaunay triangulation of a cloud of points, added as the default the best-fit plane projection, 

which may be useful for almost vertical surfaces. 

 

Version 2.2.0.11137.2  December 27, 2021 

- Updates for reading and writing geosynthetic data 

-  Adding phreatic surface from a volume 

-  Option to set whether a layer is a discontinuity.  If a layer is a discontinuity then the materials 

below the discontinuity surface are not set by the assigned material 

-  An assigned material for a layer is mandatory 

-  Add a layer from a volume.  This is accessed by right-clicking the volume, or right-clicking the 

“layers” node.  The user must choose either the top or the bottom surface of the volume, with 

vertical faces ignored 

-  Improvements for importing SLOPE/W .gsz files, and Slide .slmd files 

-  New feature – ability to include closed volumes.  If a project includes both layers and volumes, 

slopes using materials by “Layers” will only use layers, whereas if materials are by “Volumes”, then 

both layers and volumes may be used, with volumes having a higher priority than layers 

https://spatialreference.org/
https://epsg.io/


-  New cross section manipulation:  by holding down the <Shift> key while moving an end point, the 

movement will be constrained to the current cross-section direction.  The length of the cross-section 

is now displayed 

-  New file save option to save only materials. This is useful when working on projects where the 

same materials are used for subsequent TSLOPE models.   

-  Change how materials are included when both using zones and basal surface materials, so that the 

zone material overrides the basal surface material 

-  Added support for Maptek PointStudio ‘Discontinuity’ items 

-  Add Top Surface to be able to have an associated material, which allows the colour of the top 

surface to be set to be the same as the material colour 

-  Added a scale dialog when saving images, where the use of a scale > 1 increases the resolution of 

the image produced.  This is useful when creating high quality graphics for publication 

-  Add user defined field for goal FS for yield acceleration, default value is FS=1.0 

-  Increase surface file import maximum size to 1024 MB 

-  For a basal surface clipped by a layer, use the basal surface if the layer surface does not extend 

over the whole slope 

 

Version 2.1.0.9773.2  March 20, 2021 

- Option to export a surface as a VTP file 

- Provide option to use Mongolian language 

- Add reading of Datamine surface .dm files 

- When importing DXF files present a list of surface import options for 3DFACE and POINT entities by 

layer. 

- Fix for reading Slide .slmd that do not contain .slsp file.  Add reading of embedded .emf image file. 

- Allow user to edit the locations of anchors;  use ‘Edit Locations’ checkbox in the 

ReinforcementGroup panel. Use right-click on individual anchor head to popup menu to ‘Revert’ the 

anchor back to its original location. 

 

Version 2.1.0.9095.2  January 5, 2021 

- Tension crack can be defined by an angle.  Removed need to define the Z-limit when tension crack 

is defined by depth. 

- Updates to LAS/LAZ file import dialog box.  User able to select the max grid divisions, and whether 

only ground points should be used. 

- HTML reports now embed snapshot images with the HTML file itself using base64 encoding so that 

the file is self-contained. 



- Improvements for importing Slope/W GSZ files. 

- Added reinforcement types, anchor, soil nail. 

- For a surface, added a crop menu item for surfaces imported from a file. The user is able to 

interactively adjust the bounds of the crop. The cropped surface is saved as a VTP file and is added 

to the surfaces. 

- Add export surface dialog with options to export DXF and OBJ files, in addition to LandXML files. 

 

Version 2.1.0.8715.2  August 26, 2020 

- Fix for slope with basal surface defined by a layer and a boundary line. 

- Fix for generalised Hoek Brown failure criterion. 

- SIGNIFICANT ENHANCEMENT  Reinforcement is now able to be applied to 3D (and 2D) slope cases 

as modelled with anchors and soil nails.  Graphical interface allows for easy layout of reinforcement 

elements. 

- Fix for reading ASCII grid file with no data value not defined. 

- Fix for offset of phreatic and other surfaces on reading the .tsz file. 

- Improved memory handling. 

- A new option to simplify a surface using a grid-simplification is now available in addition to 

decimation.  The grid simplification may produce better performance than the decimation. 

- For cloud-of-points, the points may be simplified in the Points Preview panel by choosing a 

maximum number of divisions for a XY grid. In each grid square the points are averaged to one 

point.  The averaged points are then converted into a surface using a Delaunay triangulation. For 

large number of points this will greatly reduce the number of faces, without much loss of accuracy, 

and will improve analysis processing time. 

 

Version 2.1.0.8262.2  May 12, 2020 

- Update EPSG from geoimage and SHP annotation files where 

  possible. Coordinate system, EPSG added to HTML report. 

 

- Add labels for point loads in the 2D and 3D slope views. 

 

- For 3D slope analyses include only those point loads that are 

  applied on the slope. 

 

- Allow clip Z bounds to be adjusted for a 3D slope. 

- Hide point loads in 2D slope view if outside the corridor width. 

 

- Add option in load case panel to include/exclude all point loads, by 

  using a right-click menu. 



 

- In the Preferences panel there is a new option to set the EPSG for the 

  project's coordinate system.  To be used when writing LandXML files. 

  

- Fix to reading LandXML files where the points are in the order 

  'northings eastings elevation'. 

 

- The surface menu has a new feature to write out a LandXML file. 

- Fix for creating a surface when reading in a cloud of points on a 

  regular grid. 

 

- Added label to point-load widget to show information about selected 

  point-load. 

 

- Hide point-load widget direction handle if the point-load is 

  orthogonal to the selected surface. 

- Added a dialog box to allow the user to scale the length of the Point-load 

  arrows. The dialog box is called by right-clicking the "Point Load" 

  node or any of the Point load items. 

 

- Add feature to "drop" a .tsz file onto the Project 3D canvas to 

  open the .tsz profile file. 

 

- Update normals for cloud-of-points surface. 

- Add attributes to allow a Point-Load to be orthogonal to a top 

  surface, and optionally to set the dip while being orthogonal. 

 

- Add menu item to delete all point loads. 

 

- Add menu item to export  all point loads to a CSV file. 

 

- Importing of point loads via a CSV file updated to allow setting 

  more attributes. 

- Fix and improve search for files that may have been re-located, or 

  if the project directory has been saved in a new location.  

- Improved calculation of bounding box of 3D slope when the basal 

  surface is an ELLIPSOID.   

 

- The tool "Merge Raster Files" now assumes that the Z value of 0.0 

  for GeoTIFF files and ASCII Grid files is a no-data value, and the 

  maximum Z value for the dataset is used in place of 0.0.   

- On importing a SHP file, the VTP surface filename generated replaces 
  the SHP filename choice in the surface panel. 
 



- On importing an AGS drillholes file, if the collar height does not 
  match the top surface height, the drillhole collar is not reset to 
  the top surface, as had been done previously. 
 
- Add number of layers and features to annotation panel. 
 
- Added highlighting of drillholes; by use of a frame and bold font. 
 
- Added 'Tip of the Day' on startup to help the user about various 

  aspects of TSLOPE that may be unclear or unknown. 

 

- Update auto contour interval to be based only on the top 

  surfaces.  

- Break lock by deleting the lock file is now available for the user 

  to use if appropriate. 

- When importing a .vtk surface file that only contains points, do a 

  triangulation of the points in the file.  If there are too many 

  points to do a Delaunary triangulation, use a 500x500 grid to 

  average points as a first step. 

- Fix to ensure use of double (Float64) floating-point numbers for large GIS 

  coordinates when importing GeoTIFF files and when creating VTP 

  files through the "Merge Raster Files" tool. 

 

- Improvements to the "Merge Raster Files" Tool. 

- For the Tool "Merge Raster Files" add the optional generation of 

  surface files (VTP, OBJ) for GeoTIFF and ASCII Grid raster files. 

- New feature to merge multiple raster files (JPEG, TIFF, ASCII Grid) 

  into one raster file that may then be imported into TSLOPE. 

  Multiple tiled raster files are often provided by GIS providers such 

  as Koordinates.com, and TSLOPE requires the tiled files to be merged 

  into one file. 

- Added export drillholes geometry data as CSV file from "Drillholes" 
  menu (via right-click). 
 
- Added Drillholes geometry data to the HTML report.   
 
- For 2D slopes, the critical circle is not changed when left and 

  right outer bounds are changed. 

 

- For 2D slopes, fix to prevent adjusting left and right outer bounds 

  when analysis is a critical search. 

 

- Lock filename is now <filename>.tsz.lock so that it may be easily 

  visible to the user, if it needs to be deleted (e.g. if TSLOPE is 

  not exited normally). 



 

- If an analysis is done with a layer as basal, and the layer doesn't 

  have the same coverage as the basal surface, the z height of the 

  basal surface will be used.  NB: This may result in unexpected 

  geometry for slices or columns. 

- Fix to allow 2D slope have basal surface defined, assumed to be 

  critical search analysis where the basal surface will be 

  automatically created. 

 

- For Composite surfaces, allow user to select the composite function, 

  min or max.  This may be useful to model a top surface with a fill 

  surface. 

 

- Allow user to copy a top surface to become a phreatic surface. 

 

- Add lock file for opened .tsz file to help ensure multiple users do 

  not overwrite other user's .tsz files.  A file opened by another 

  user may be opened in read-only mode and any changes made may be 

  saved to a different file. 

 

- Added files with extension '.wld' as a "world file" type for 

  geo-referenced images (GeoImages). 

 

- For vertical uniform loads add the 'Draw' button to let the user 

  draw the boundary line on a top surface. 

 

- For surfaces with non-manifold edges, raise error dialog message 

  instead of warning message in log panel which may not be noticed by the 

  user. 

 

- Colour warning and error messages in log panel to make them more 

  obvious. 

- Increasing log information as reported in /Documents/TAGAsoft/TSLOPE/tslope_err.log.  If you 

need to report an issue to support@tagasoft.com, please attach this file to your email message. 

 

- Add delay to updating slope when changing back-analysis parameters. 

 

   

 

Version 2.1.0.7682.2  February 3, 2020 

   

- New dialog box to add points for boundary line and locate on nominated surface. 
 
- Import point loads from a file. 

 

mailto:support@tagasoft.com


- Added option to constrain point loads to a top surface. 
 

- Windows 7 no longer supported now that it is end-of-life. 
 
- Updates to Maptek connection. 
 
- Improved decimation of surfaces. 
 
- Add save grid surfaces as OBJ, CSV from the 3D Slope Data menu. 
 
- Added Anisotropy to failure criterion "Vertical Stress Ratio". 
 
- For Slope CSV data file output, output points and vectors as x,y,z components. 
 
- For Maptek surfaces copied to temp file, the file is copied to the directory of the saved .TSZ file. 
- Show dialog error if the .TSZ file (a ZIP file) is invalid or corrupt. 
 
- MAJOR CHANGE: now saving relative filenames with respect to the project directory where the .TSZ       
file is saved, or full absolute filenames if the filename drive differs from the project drive.  For File -> 
Save As, if the destination directory is different from the source directory, the user is asked whether 
to copy the surface data files to the destination directory.  Especially useful if saving to a USB stick or 
network drive. 
   

- Improvement for Generalised Hoek Brown failure criterion to return more accurate shear strengths 
for low effective normal stresses. 
 

 

 

Previous release notes included the following: 

1. When applying your TSLOPE licence, watch for a flashing icon on your task bar – that 

needs to be opened to accept the license. 

2. When accepting the on line licensing option, you may get an error message.  If this 

happens it is likely to be due to your network security settings.  You will then need to follow 

the off line licensing instructions (see below). 

3. Please make sure that you are using the latest version of your graphics driver. 

4. Check back to our web site downloads page from time to time for updates to TSLOPE. 

5. Limit the size of the project area that you are working on, as this will improve overall 

program performance. 

6. We have increased the limit on the size of surface files that can be imported to 300 MB. 

7. Ctrl right mouse click will give you a coordinate at a point in your model. 

8. Switch between solid and wireframe view with W and S keys. 

9. TSLOPE will not run on Sony Vaio Z-series laptops that use the dynamic hybrid graphics 

system.  

10. TSLOPE results are available in a .htm file.  Graphics are not embedded in the file, but are 

available when viewing the .htm file on your system.  You can also take the .htm file into 

Word and edit it.  Graphics will also be viewable.  However if you send either .htm or .doc 



files to another computer, the graphics will not be transferred.  The work around is to save 

your work to a .pdf file. 

11. New options are available for specifying shear strengths.  You can associate a shear strength 

with a basal surface, and each component of a composite basal surface will then have the 

appropriate strength applied.  You can also use 2D polygons to specify the shear strength 

over an area of the basal surface (zones).  These choices are selected in the Slope case-

Analysis-Materials definition tab. 

12. TSLOPE saves report snapshots to the project file (.tsz).  If you are working with an existing 

TSLOPE model you should clear any previous report snapshots before you print your report. 

13. Improved 3D discretisation of slopes with Basal Composite surfaces. 

14. A new option allows Project Clipping.  You do not need to define the project limits ahead of 

loading data, now you can clip all of the surfaces to suit project requirements, and to focus 

on the area of interest.   The Project Clipping menu is accessed from the Preferences menu. 

15. Maximum file size for a cloud of points that can be loaded to TSLOPE is 50MB. 

16. Where a surface is defined by a cloud of points, there is now an option for the user to set 

whether the points are regularly spaced or not.  This fixes an issue when there are gaps in 

the points, changing the Spacing is regular option to False will force a Delaunay triangulation 

of the points. 

17. New surface file import supported for STL surface files, PLY (ASCII) files, ESRI Arc/Info ASCII 

grid files (*.asc). 

18. Multiple instances of TSLOPE can now run on a PC.  

19. New File -> Open Example (examples provided with installer) 

20. Significant performance improvement particularly with large 3D models. 

21. Anisotropic strength properties can be used for both 2D and 3D slope stability analyses. 

22. Point query (using Ctrl left-click) of 3D slope basal surface reports: Point, material, OMC local 

FS, total normal stress, effective normal stress, pore pressure, normal vector. 

23. Materials now have a colour attribute, that can be displayed in 3D slopes using data menu 

"Material Colour". 

24. New feature: slope materials mapping, defined in new slope materials panel.  This allows the 

user to change the material associated with layers, zones, and basal surfaces.  The default 

material may also be changed. 

25. Import Slide .slim .slmd and SLOPE/W .gsz files. 

26. Import CSIRO OPS/SiroModel Project .opp file. 

27. Add threshold minimum column height to Slope Analysis Advanced section panel. This 
allows columns with height less than the threshold to be ignored. This may be helpful where 
the top surface and basal surface are almost coincident and unwanted columns are included 
in the slope.  The default value is 0.0. 

28. For Layers and Surfaces, "Hide All" and "Show All" right-click menu items when more than 
one surface in the group. 

29. Improved definition of columns in 3D slope cases defined by Composite surfaces. Filter out 
low count independent groups of columns, keeping only the columns belonging to the 
highest count contiguous group of columns. 

30. Drillhole location information can be imported and displayed in Project view as annotation. 
31. Import of multiple AGS file(s) has been enabled; using Ctrl-Left click for non-contiguous 

selection, or Shift-Left click for block selection. 
32. We have increased the number of points that can be loaded to define a surface from a cloud 

of points file to 200,000. 

33. Cloud of points file with number of points between 200,000 and 1 million can only be used 

for annotation purposes.  Point size in the display can now be set. 



34. Implementation of vertical stress ratio failure criterion. 

35. Direct read surfaces and discontinuities from Maptek’s PointStudio and Eureka programs. 

36. Change to licencing – if user does not have admin rights, licence can be loaded in user 

registry. 

 
 

 

Minimum System Requirements 

1. OS: Windows Vista/7/8/10.   Note only Windows 10 is supported. 
2. CPU: Multi-core, 1Ghz or faster. 
3. RAM: 4 GB 
4. Three button mouse. 
5. Graphics: a dedicated graphics card. 
6. Monitor: 1024x768 or greater. 
7. Disk: 180 MB free disk space. 

 
 
 
 
Licencing Process – Online 
 

1. Download and run the latest version of TSLOPE  
2. The programme will allow inputs but will not allow “solve” until a licence key has been 

obtained. 
3. On pressing “Solve” for the first time a pop-up box will request a licence code. 
4. The licence key can be found in the email from orders@tagasoft.com informing you that 

your order is complete (the key is an alpha numeric code “X-xxxx-xxxx” or “X-xxxx-xxxx-xxxx”). 
5. Enter the code and select “Obtain Licence” – TSLOPE is now licenced for the period of 

purchase or trial. 
 

 
 
 

 
Licencing Process - Offline 
 
Here is the step by step process for licensing TSLOPE when the PC on which it is installed is 
unable to connect to the TAGAsoft license server. 
1. Start TSLOPE on you offline PC 
2. Select Help → Install Licence which will bring up the TSLOPE License Manager 
dialogue. 

mailto:orders@tagasoft.com


 
 
3. Enter you purchase code, press Generate Licence Request, and save the licence 
request file to your local disk. 
4. Transfer the licence request file to a PC or device connected to the Internet. 
5. Visit the TAGAsoft Website https://tagasoft.com/license   Make sure you are using the secure web 
address, so best to copy and paste this URL into your browser. 
 
 

 
 
6. Upload the licence request file (drag and drop or browse), press Send Request to obtain your 
licence file. 
7. Transfer the licence file to the original offline PC: Start TSLOPE; Select Help →Install Licence; Press 
Install Licence File to install the licence file. 

https://tagasoft.com/license

